Visual COBOL for Visual Studio Getting Started with Solutions, Projects and the

1)

COBOL Call Statement

Overview

1.

Solutions and Projects

In Visual COBOL for Visual Studio, the main unit of work is called a solution. Solutions can contain multiple
projects. These projects can be managed code COBOL projects or native code COBOL projects or can be
C# projects or VB.NET projects, etc. Visual COBOL projects can contain only COBOL programs or classes
but these programs and classes can interact with the programs or classes contained within projects
written in a different language like C#.

There are two basic types of projects, Application projects and Library projects. Normally, a solution
would contain a main Application project like a Windows Forms Application, WPF Application or a Console
Application. Application projects generate an output file with the .EXE extension and contain the main
entry point of an application. Library projects, like a Class Library or a Link Library typically contain
programs and classes that are called by the main application project. Library projects generate an output
file with the .DLL extension.

Each project can contain one or more source programs or class programs. In managed code, each project
is compiled into a single output file called an assembly. In native code COBOL Application and Library
projects you can also select to have multiple output files. In this case, each individual program within the
project will be compiled into its own .EXE or .DLL.

Problems with Calling Programs Located in Different Projects

Each project specifies an output folder into which its generated output files will be stored. The default
name of this folder varies depending on the project CPU settings and which build type you are using such
as DEBUG or RELEASE. The default location is in a subfolder which is relative to the projects main folder,
i.e., .\bin\x86\debug. This default name of the output folder is configurable under the COBOL tab of the
Project Properties page.

There are two issues that need to be addressed when a program in one project calls a program in another
project.

1. Programs that are called cannot be found.

When an application is started in Visual Studio the output folder in which the main application resides will
become the current folder. Programs that are called must either be placed in this startup folder or all
programs must be placed in a different folder or they must reside in a folder that is locatable via
environment variable PATH.

2. Entry points that are called that are different from the name of the .DLL cannot be found.

When the name of the program in the call statement matches the name of the .DLL on disk then it will be
found as long as the conditions in 1 above are true. But if calling an entry point which is the name of
another program within the .DLL or the name of an entry point specified in an ENTRY statement within a
program in the .DLL, the .DLL containing the program to be called must be preloaded in order to make its
entry points visible to the run-time system. This can be done using one of the following methods.

- set proc-pointer to entry “dliname”

- Micro Focus Entry Name Mapper (MFENTMAP)

- Interop Preload section of app.config file (managed code only)

All of these scenarios will be covered in the tutorials that follow.
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1) Working with Native COBOL Projects

In this tutorial you will be shown how to setup and use a Visual COBOL solution containing a main application
project and a Link Library project containing a program that will be called.

Start Visual COBOL and from the main menu select New->Project as shown below:

o e i T Y
| File | Edit View Debug Team Data Tools Test Window Help
' Project... CtrisShiftsN | |

New 4 B
| =
| Open * | '@ WebSite.. Shift+AltsN 5]
Close Ljg Team Project...
Close Solution 1 File... Ctri+N
7 Save Selected ltems Ctrl+§ Project From Existing Code...

T

On the New Project Dialog select Native under COBOL, highlight Console Application and then change the
Project Name and Location to nativemain and C:\nativemain respectively. Also uncheck the option for Create
Directory for Solution so that your project will have the same folder structure as shown in this tutorial. Click

OK to create the new project.
[New Project — =
2|

N } Sort by: (Ddault | Search Installed Templates
Installed Templates
Type: COBOL

CBL | Windows Application COBOL
4 COBOL = A project for creating a native command-

line application

Recent Templates l NET Framework 4

Database
Managed Console Application COBOL

!@El;
Web Empty Project COBOL
Visual Basic
Visual C# EFBL;
Visual C++
Visual F# (e Micro Focus INT/GNT COoBOL
Database
Test Projects
Other Project Types

Online Templates

Link Library COBOL

Name: nativemain

Location: c:\nativemain - | Browse... l
|| Create di irectory for solution

|| Add to source control

Coc | o

Solution name: nativemain
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Visual COBOL will automatically create a solution with the same name as your project file and will add a new
Program1.cbl file to the project. If you do not see the Solution Explorer Window or the Properties Window you
can select to display them under the View menu item.

oo nativemain - Microsoft Visual Studia — — lill-“—‘l - X
E-ilg~—iah View Project  Build quqg Team Data loqE_fe;t Window Help

S S T v AT ' B e N B I R e ,.',|>|Debu9 -]sts ) 'HL’;—

b s R ae T [ame e | 2 21 R a1 el b 2 e ) (L ) ol i)l el | Change Tepe =

Programl.cbl [Code] = Selution Explorer v B x

- oy |
identification division, | A Solution 'nativemain’ (1 project)
program-id. Programl. 4 97 nativemain
|4l Properties
il References
|l Programl.chl|

environment division,
configuration section.

data division,
working-storage section.

procedure division.
goback.

end program Programl. ERUETIVIN W Tearn... BB Class..,
Properties v i x

Programl.cbl Compile Item Properti »
s EE
0% v 4
e Build Action  Compile
Output Copy To Outpt Do not copy
Shew output from: | General Custom Tool
Custom Tool h

Full Path chnativemain\ne ~

Bulld Action
Action to be executed on build

" Program Breakpoints (Native,.. I Watchpoints (Native COBOL) “ Error List

IntelliSense updated - 0 srrors

Modify the source code to Program1.cbl in the editor so that it looks exactly like the image below:

identification diwvision.
program-id. Programl.

; Solution 'nativernain’ (1
4 2 nativemain

=d| Properties

=« References

[m| Programil.chl

- o

environment division.
configuration section.

data diwvision.

1

working-storage section.
81 myparams pic x(28) wvalue "from progl”.
procedure diwvision.

call "program2™ using myparams
goback.
£ Soluti...

B Team...

end program Programl. .
preg 8 Properties
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Now we will add a second program to our project. Right click on the Project name in Solution Explorer, which
is the nativemain in bold with the CBL icon next to it and select Add->New Item.

Solution Explorer

=| # myparams

=

identification diwvision.
program-id. Programl.

envirconment division.
configuration section.

data division.

working-storage section.

81 myparams pic x(2@) wvalue "from progl"”.
procedure division.

s Mew ftem...
2 Existing ltern...
4 Mew Folder

v 0 X
; Solution 'nativemain’ (1 project)
4 |24 nativemain

Build
Rebuild

Clean

Ctrl+Shift+A Add 4

call "program2” using myparams
goback.

end nrnoram Draoeaml

Shift+Alt+ A Add Service Reference...
Add Existing COBOL Items...
Set as StartUp Project
Debu 3
& Soluti.. <

% Add Solution to Seurce Contral...

Highlight COBOL Program from the list and then click the Add button at the button to accept the default name

of Program2.cbl.

r — =
Add New Item - naﬁvem‘ail ad

Installed Templates Sort by: | Default

4 COBOL Items T
Native Lu]

Online Templates

COBOL Program

Copybook

Application Configuration File

Resource File

Program2.cbl

| Search Installed Templates pel ‘

Type: COBOL Items
A new COBOL program file

COBOL Items

COBOL Items

COBOL Items

COBOL Items
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Edit Program2.cbl so that it looks like below. Make sure that you change the program-id from Program2 to

Prog2 and then delete the end program statement at the bottom.

Program2.cbl [Code]* < RailvleTiy Wa i (o5

= Solution Explorer

0[3 Prog2 -

W procedure division

=

identification division.
= program-id. Prog2.

environment division.
configuration section.

data division.
-] working-storage section.
-] linkage secticon.
@1 myparams pic x(2@).
-] procedure division using myparams.
move “"from prog2” to myparams|
goback.

; Selution 'nativernain’
=1 nativemain
=d| Properties

vl

g References
[m] Programl.chl
[m] Program2.chbl

L"-‘f‘g Soluti... [ REEl

Press the F11 key to build the project and start debugging. The current statement should be highlighted as

shown below. Press the F11 key again to execute the current line.

00 ratvermain (Debugging) - Mcrosoft Visusl Studio —
a«wr«ws«mmrmmxookww&"&

e 2% (7 R0 SR RENED BER R LR N . ‘_,‘o;em;m “i%
e Gl T2l 0 dudpld Al r Laalo@E5yide F|Jsi3 AT E0 0EC
© Process {6304] nativermsinee ‘ = | Themaet * [T452] <No Name> - [N ;' - - -
Programl cbl {Code] X
5 Programl = W peocedure dvision N B
identification division, - Sclution 'nativemain’ (1 peoject)

program-1d. Frograsi.

divisicn,
configuration sectlon.

envirorment

data division.
working-storage section,
81 myparam pic

procedurw division,

x(20) value “from progl”.

kall “program2” using wyparams

goback.
end progreas Prograsi,
W% - =
Namwe Ve
v mypamams from progl
=1 Autos

Type
PIC X{20

+

[

+ 5 pativemain
W Properties [
i References
i Programl.chi
& Program2.chd
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Control should now be given to the called program, Program2 as shown below: Continue to press F11 to step
through the rest of the statements and return control to Program1. Press F11 on the goback statement in
Program1 to exit the debugger.

(&L Programl.chl [Code]

vl W procedure division

identification divisicon.
program-id. Prog2.

envirenment division.
configuration section.

data division.

working-storage section.

linkage section.

@1 myparams pic x(2@)

procedure division using myparams.
jpove "from prog2” te myparams
goback.

Notice that the call statement was referencing program2 which is the name of the program on disk and not
the name of the program in the program-id. Now change the name in the call statement from program2 to
prog2 as show below and then press F11 to start debugging again.

Programl.cbl [Code] X

'l “ procedure division

identification division.
program-id. Programl.

environment division.
configuration section.

data division.

working-storage section.

@1 myparams pic x(28) value "from progl”
procedure division.

call "prog2" using TyparaTﬂ
goback.

end program Programl.

Press F11 to step through the call statement and into program2. Complete the debugging by pressing F5 to
run the rest of the program. This is the behavior of the CALL statement in Visual COBOL. You can call a
program by its name on disk or by its program-id, if the two happen to differ.

This works fine in this example because both the calling program and the called program both exist in the
same project. We will now place the two programs in separate projects to demonstrate a common scenario.
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Right click on the Solution name in the Solution Explorer window and then Select Add—>New Project as shown
below. Make sure that you right click on the Solution name which will be at the top and not the Project name
which will be under it.

Solution Explorer * R X
-1 W procedure division B e
fidentification division. ) “3 Solutia ' ol o X
program-id, Programi, o 4 pat (G Build Solution Ctele Shifts B
™) Rebuild Solution
environment division.
configuration section. '\: Llean Solution
: | Bateh Bulld..
data, divisian, & - Cgnfiguration Manager..,
working-storage section. I |
01 myparams pic x(20) value “from progl", [ New Project,,, Add
procedure division, | Existing Project... Sot StartUp Projects..
call "prog2" using myparams New Web Site.,. 4, Project Details Window
back, i
oy EAIRIng WAR S (8 Add Solution to Source Control..
end program Programl, il New Item.., Ctrls Shifte A M Paste Ctrl+V
4l Bxisting Ttem,, Shift+Alt+ A Rerdme
~ - NewSolution Folder (N Mnan Balobas la s daiie Eonlacas

Select Native under COBOL and then Link Library as the project type. Change the name of the project to
program2 and leave the Location set to c:\nativemain so that the new project will be in a subfolder of the
main solution. Press Add to add the new project to the solution as shown below:

- -
Recert Templates = Em.yl ,Ddlul
Instalied Temnplates

2 Windows Apphcation COBOL Types COMOL
4 COBOL A native propect for cresting dasses usable
Databace by other applications
Managed Consele Applicatica CoeoL

==

Web e | Empty Project CoBoL

Vesual Basic

Visusl C= Link Library COBOL
Vaua Coe

Vousl F= Micro Focus INT/GNT COoBOL
Database

Test Projects

Other Project Types

Online Tenplates

programd

cAnativernan

The new project program2 will be created and the default program Program1.cbl will be added to it.
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We will not be using this Program1.cbl so we will delete it from the project. Right click on Program1.cbl in the
program?2 project and select Delete as shown below. Make sure you are deleting the Program1.cbl from the
program?2 project and not from the nativemain project.

Programl,chl (Code] > JRET RG] Programl.chl [Code) Solution Explorer v ) %
'l ’ l-l-ll \J’
fdentification diviston, 0 [ Solution 'nativemain' (2 projects)
program-id, Programl. a0 mativemaln
| dl Propertion
environment division, @ Referances

configuration sectlon, (& Programi.ch)

data division, & Programd.chl

working-storage section, r 4 W0 program2
A Propaties
procedure division, ol Neferences
&) Proeeamt shil
Roback, | ]' Qpen
end program Programl, @3 Soluti, Opay With..

Properties 3 Compile

Programi ehl Exclude From Project

» 91 ' | Croate Project,

Py Cuy Clrie X
ok . fulld Actia 94 Capy Crle €
Output Copy To 0| x Delete Del
Show output fromi | Debug o] g L% | % | gl Custom Td Rename

The thread '<No Name>' (0x11b0) has exlited with code O (0x0), Custom Te

- Ruset source directives
The progeam '[(S348) nativemaln, exer ci\nativemaln\nat fvemaln\bin\x86\debug\nat l\mm.ln.nl
|

Full Path

bl Properties Alt+ Enter
Confirm the deletion when prompted to do so.

Now move the program2.cbl source from project nativemain to project program2 by dragging it from
nativemain to the project name program2 (with CBL project icon next to it) You could also do this by right
clicking on Program2.cbl in nativemain and selecting Cut and then right clicking on project name program2
and selecting Paste. Your solution should then look like the following:

ode] X ~ Solution Explorer

=Y

; Selution 'nativernain’ (2 projects)
4 CEEE nativemain
=d| Properties
«al References
[m Programl.chl
data division. &0 program2
i=d| Properties

-l ‘W procedure division

identificaticon diwvision.
srogram-id. Programl.

LK

znvironment division.
configuration section.

m

working-storage section.
3l myparams pic x(28) value "from progl”. =l References
asrocedure division. [@ Program2.chl

call "prog2” using myparams
goback.

W Team... EBR Class..

Now Press F11 to rebuild the solution and start debugging again.
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This time when you step the call statement it will fail with the following error:

Programl.cbl [Code] X Solution Explorer

“% Programl '] ¥ procedure division m =) )
identification division.
= program-id. Programl.

4 Solution 'nativemain' (2 projects)
4 %Y nativemain

s

. g =4| Properties
environment g microsoft Visual Studio = References
configuration

|m] Programl.cbl

data divisial l \ 173  Called program file not found in drive/directory: prog2 ¢ program2 .
& working-stor3 - =d| Properties
@1 myparams g References
= procedure di [g] Program2.cbl
call "pr{i
geback.

end program §

Continue Ignore

100% ~ ¢

The Run-time System error 173 means that the name of the program name referenced in the call statement
could not be found. Click on the Break button and then select Stop Debugging from the Debug menu item (or
press Shift-F5).

Change the name in the call statement from prog2 to program2 and debug again by pressing F11. The same
error occurs. So what has changed?

The difference is that program2 is now in a different project which has a different output folder than the
calling project.

nativemain.exe is in C:\nativemain\nativemain\bin\x86\Debug

and

program2.dll is in C:\nativemain\program2\bin\x86\Debug

When the application is started the folder containing the startup program becomes the current folder so any
programs that it calls, such as program2.dIl must either also be in the startup folder or they must be in a folder
which is referenced in the PATH environment variable.

Let’s try the following. Stop Debugging and then right click on the project name nativemain in Solution

Explorer and select Add—>New Item as shown below:
Solution Explorer v 3 x
ale
g Solution 'nativernain’ (2 projects)

~| =% procedure division

identification division. =
program-id. Programl. - 4 cia nativemain
4| Pro| (£ Build
envircnment division.
+3 Ref r
configuration section. = RERE
& Pro
Clean
data division. 4 cia prograt . -
working-storage section. = = Pre =R ey E A =
@1 myparams pic x(2@) value "from progl”. [ Ref Project Build Order...
procedure division. s
] New Iem.. Ctrl+Shift+A Add
call “"program2" using myparams (] Existing Item... Shift+Alt+4A Add Service Reference...
goback. Cif | New Folder Add Existing COBOL ltems...

end program Programl. Set as StartUp Project

MNehin
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Select Application Configuration file from the list and accept the default name of Application.config by clicking

on Add.
- Y
) wnplel o
4 COS0L hems
Mothve O CO8O0LProgram COBOL tems Type: COBOL tems
- A file uted to configare Applcation
Ondine Templntes A et
Onldine Template: » Copybook COBOL Items =
L_] Apphcaton Configuration File COBOL ftems
= | t .
A Resource File COBOL frems

Apphcation config

The file will be added to the nativemain project. Right click on Application.config in Solution Explorer and
select Edit.

Solution Explorer v i} X

«| @ procedure division ]
identification division, [l 3 Solution 'nativemain' (2 projects)
program-id. Programi. “l 4 U1 nativemaln

Wl Propertiey

nnvl}rnnmrnt division, i@l References
conflguration section, [ \
| )] ApF‘-llrnMnn eonfin!
[m] Proj L] Open

data divislion,

working-storage section, Ell 4 &1 progray Open With,.,
QL myparams pic x(20) value “"from progl", o l’m‘ Edit
procedure division, [ Refy
] Pm; Exclude From Project
call "program2” using myparams -
goback, | & Cut Ctele X
50 Soluti,., da Copy CtrlnC
end progeam Programl, % Delete Del
MicraFocus.CQ Rename
ma L Properties Alt+ Enter
b e P
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In the popup editor that appears add the value PATH in the name field and enter the location where the
program?2.dll resides followed by “;%PATH% in the VALUE field and press SET. Then Press OK to save this. The
;%PATH% portion tells it to append the current setting of PATH to the new one.

7

! Application Settings @
Environment | COBOL Switches |

Variable Value
PATH c:\nativemain‘\program2\b...

L | 2]

Name PATH

Value  k:\nativemain\program2'bin'x86\debug;%PATH% H

(se ] [(osee ]
I |

[ ok || cancel | |

Press F11 to start debugging again and when you execute the call “program2” statement it will now work. Life
is good right?

Programl.cbl [Code] > ~ Solution Explorer
~| =% procedure division - | B

identification division. + ; Solution "nativemnain’ (2 projects
program-id. Programl. + 8 4 (27 nativemain

. L =d| Properties
EﬂVlITDI"II'I'IEI"IF lelSl?ﬂ, =] References
configuration section. x — .

7| Application.config

data division. [l Programl.cbl
working-storage section. 4 CEE:H pragram2
@1 myparams pic x(2@) value "from progl”. =4 Properties

procedure division. «3] References

[ Program2.chl
call "program2” using myparams

goback.

Stop debugging and change the name in the call statement from program2 to prog2 which is the program-id of
the program to be called. Now press F11 to step through the call statement again. Look familiar?

Pragoamd.che iCotel >

[FeProgramt o] % pincedure Senmn § B

Lt ifLcatbon o 1an A SN e (2 e pecy
o 10 nativermain

i Frapeties
N

envirmment divisl y
" T Mutureft Vaust Lhube
Clger st lun i
P " viey
Aate divialon m ) e fbe et found o diee desctary progd
worbing- storage Section ]
08 wypar e phe we2e) voll
) \ it
bakl “progl® using sypardy
frmaih
vl pragrae
W e ]
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The reason that it worked when calling “program2” is that program?2 is also the name of the .dll file on disk,
program2.dll. When the call statement is executed the run-time system first checks to see if an entry point
named “program?2” has already been loaded. If it has then it will call that one. If it hasn’t been loaded, then it
next tries to find a program with that name on disk in the current folder. If that search fails it will search
through the folders specified in PATH, looking for a program called “program2”. In the case of this tutorial
“program2.dll” will be found and loaded and then “program2” will be called.

The reason why it failed when calling “prog2” instead of “program?2” is that there is no program called
prog2.dll available on disk.

In this case where you wish to call an entry point of a program that resides within a .dll that has a name other
than the name of the .dll itself then the .dll must be preloaded in order for the call statement to find the entry
point. This is true when calling by program name or by the program-id name if they differ. This also applies to
programs that have multiple entry points by using the COBOL ENTRY statement. Of course, if you have already
called the main entry point of the .dll, in this case “program2” then the .dll will already be loaded and its entry
points made available.

There are a couple of methods that can be used to preload a .dIl whose main entry point has not yet been
called when working with native code.

First is by setting a procedure-pointer variable to the entry of the .dll name.

Add a variable called pp to the working-storage section of program1.cbl and then add the set statement as
shown below before the existing call statement.

identification divisicn.
program-id. Programl.

envirenment division.
configuration section.

data divisicn.

working-storage secticon.

@1 myparams pic x(28) value "from progl”.
@1 pp procedure-pointer.

procedure division.

set pp to entry “program2"
call "prog2" using myparams

goback.

end program Programl.
The set statement will preload “program2.dil” and make any entry points in it visible to the COBOL run-time
system. Remember that this will only work if the PATH in the application.config file includes the folder where

program?2.dll resides.

Press F11 to start debugging and step through the call statement to show that it now works correctly.
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The second method to preload a .dll is to use the Micro Focus Entry Point Mapper or MFENTMAP. This is more
complicated to configure than simply using a procedure-pointer but we will include it here for the sake of
completeness.

First, comment out the set statement in our current program by placing an asterisk in column 7 of its source

line as shown below so that the program2.dll will not be preloaded.
identificaticn divisicn.
program-id. Programl.

environment divisicn.
configuration section.

data division.

working-sterage section.

@l myparams pic x(28) walue "from progl”.
@1 pp procedure-pointer.

procedure division.

set pp to entry "program2”
call “prog2"” using myparams
goback.

end program Programl.

Open up Notepad or any text editor and create a file containing the following three lines:

[ENTRY-POINT] prog2
[PROGRAM-NAME] *
[SUBPROGRAM-NAME] program2

Save this file in your nativemain project folder using the name “mfentmap.dat”.
If using Notepad, ensure you change the file type to All Files so that it will not add the extension .txt to the file.
So the file will be called C:\nativemain\nativemain\mfentmap.dat.

~
| Save As — @
_—— :
@Uq| <« nativemain » nativemain » v | s H Search nativemain )
Organize v New folder §== w @
»
“# Dropbox 2 Name Date modified Type
| Recent Places : i
bin 8/25/2012 6:16 PM File folder
e obj 8/25/20126:16 PM  File folder
4 Libraries X
= | Properties File folder
|-¢| Documents a2 ; -ANEIG
A X | Application.config CONFIG File
@ Music & : : < ~OBO
(I Fgﬁ nativemain.cblproj COBOL Proj
k=| Pictures % g
— | nativemain.dep DEP File
% nativemain.sin Microsoft Vi
' B nativemain.suo 8/27/2012817 AM  Visual Studid
1% Computer Tl 2
B : |*| Programl.cbl 8/27/20129:06 AM  CBLFile
fse Local Disk (C:)
#3 DVD RW Drive (D _ . ;
File name: mfentmap.dat o
Save as type: | All Files (*.%) v]
4 Hide Folders Encoding: [ANSI v] [ Save l [ Cancel ]
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When using MFENTMAP you would create the three entries shown in the file for each of the entry points that
you would like to make known to the run-time system.

[ENTRY-POINT] prog2 - This is the name of the entry point used in the call statement.
[PROGRAM-NAME] * - This is the name of the calling program. Use * to mean any program.
[SUBPROGRAM-NAME] program2 - This is the name of the program that contains the entry point.

In our case when calling “prog2” the run-time system will first load “program2” if required in order to find
“prog2”.

To complete the setup we must set a couple of environment variables.
Right click on the application.config file in Solution Explorer and select Edit.

Add the new environment variable ENTRYNAMEMAP with the value of the mfentmap.dat file that we saved
previously. Press Set and then OK to Save it.

-
sl Application Settings @

Environment | COBOL Switches |

Variable Value
PATH c:\nativemain‘proara...

Name ENTRYNAMEMAP

Value c:\nativemain‘nativemain‘mfentmap .dat

[ Set || Delete |

@[ g (fmeie) _LJ

We must also create a cobconfig.cfg file containing the RTS tunable entry_point_mapper=TRUE in order to
turn on the support for MFENTMAP.

Open up Notepad or any text editor and create a file containing the following line:

set entry_point_mapper=TRUE
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Save this file in your nativemain project folder (same location as mfentmap.dat) using the name
“cobconfig.cfg”. If using Notepad, ensure you change the file type to All Files so that it will not add the
extension .txt to the file. So the file will be called C:\nativemain\nativemain\cobconfig.cfg.

| Save As
3 =i
@uv‘ « npativemain » nativemain » v | 4 | Search nativemain P ’
—=
Organize v New folder 3= w @
“# Dropbox * Name Date modified Type
%] Recent Places  — ;
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o 2 obj 25/20126:16 PM  File folder
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.. Properties /25/2012 6:16 PM File folder

\:ﬂ Documents
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|| Pictures

/2772012 9:34 AM CONFIG File
/2772012 9:26 AM DAT File
/27/2012 8:44 AM COBOL Proj
27/2012 8:44 AM DEP File
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O W ®
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#2 DVD RW Drive (D , :
w =4 i | 3
File name: cobconfig.cfg G
I Save as type: |All Files (*%) v] I
4 Hide Folders Encoding: [ANSI v] [ Save J [ Cancel ]

We must now set the environment variable COBCONFIG to point to the location of the file we just created.
This environment variable must be set in the computers environment as it cannot be set within the
application.config file.

Open up Control Panel>System—>Advanced—> Environment Variables and select New under System
Environment Variables. The location of this option is system dependant but under Windows 7 it can be found
under Computer->System Properties.
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Enter COBCONFIG as the variable name with a value of c:\nativemain\nativemain\cobconfig.cfg then press OK
to saveiit.

In order for Visual Studio to pick up the new value it must be restarted.

Click the Save All icon from the IDE menu and then close Visual Studio by clicking the X in the upper right hand

corner.
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Start Visual Studio again and select our project nativemain from the list of recent prOJects to reopen our
solution. You can also use the File>Open->Recent Projects and Solutions option.
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Start debugging by pressing F11 and step through the call statement. “prog2” will now be found via
mfentmap.dat.
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If you have a large number of Link Library projects in your solution it may become a hassle to have to set the
PATH to include the output folders of every project. In this case it may be advantageous to change the output
folders of all projects to point to a common location such as the output folder of the main application or a new
common folder. You must remember that when doing so you must change the output folder for each build
type as these specify different locations.

Let’s give this a try. First right click on the application.config file under Solution Explorer and select Edit.
Highlight the entry for PATH and click the Delete button. Then click OK to save it. Leave the ENTRYNAMEMAP
entry alone for now.

ol Application Settings @

Variable Value
PATH

ENTRYNAMEMAP c:\nativemain‘\native...

Name PATH

Value c:\nativemain‘program2'\bin‘\x86\debug; %!

[ set [ Dok |

@i == Q

In Solution Explorer double-click on Properties under the nativemain project heading to display the Properties
page below. Click on the COBOL tab to the left and scroll down until you see the entry for Output Path: Change
the current value to ..\compiledprogs\bin\x86\debug. This will place the project output into folder
c:\nativemain\compiledprogs\bin\x86\debug. It is best to use the relative paths like “..\” instead of
hardcoding the names in case the solution is moved to another folder.

Click on the save icon to save the changes.

QEUELFTLR S Program?2.cbl [Code] Programl.cbl [Code] Solution Explorer

|&
Application ; Solution 'nativemain’ (2 projects)
Configuration: [Active (Debug) v] - .;E@ nativemain
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brrors and warnings ) p
COBOL |5 Programi.chl
Warning level: [Includewarnings (Level W) - a ‘5@ programs
COBOL Link =d| Properties
Stop aften: 100 [T] Treat warnings as errors | gl References
Debug Programa.cbl
Output E B g
AT . CompiledProgs\bin\u6\Debug| E_ W% Team... BB Class
[7] Generate directives file [7] Generate listing file Properties > 0 %

Additional directives

4 | 1 | 3
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Close the nativemain property page and open up the property page for the program2 project and make the
same changes that you made to nativemain using the same Output Folder name of
.\compiledprogs\bin\x86\debug.

Save this and start debugging again by pressing F11 and “program?2.dll” will be loaded by the run-time
without the need for the PATH to be set because “program?2.dll” now resides in the same folder as the startup
program nativemain.exe.

Delete the application.config file from the project by right clicking on its name in Solution Explorer and
selecting Delete. Then uncomment the set statement in program1.cbl so it once again will set the procedure-
pointer and load “program2.dll”. Debug again by pressing F11 and “prog2” will now be found without the
need to set either PATH or ENTRYNAMEMAP.

Remove the COBCONFIG environment variable from the computers environment by opening up Control
Panel->System->Advanced—> Environment Variables, selecting COBCONFIG in the list and clicking Delete.

Close Control Panel and Close Visual Studio.

We have now completed the section on Native Code development. The next section will go through the same
exercise using Micro Focus INT/GNT projects instead of native.

Summary

We have covered a number of different scenarios here in the preceding tutorials, some of which may or may
not be applicable to your particular application.

The chart below summarizes the techniques that we covered in these pages and outlines under which
scenarios each can be used.
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